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Introduction 
 

Overview 
 
TamoGraph LTE and 5G Edition is a design and analysis environment for planning, visualizing, and assessing 
the performance of LTE and 5G NR networks, with a primary focus on private deployments. Typical projects 
include CBRS and similar private cellular systems in campuses, industrial sites, and enterprise venues, where 
you control both the infrastructure and the spectrum usage. TamoGraph LTE and 5G Edition builds on the 
proven foundation of TamoGraph Site Survey, a widely used tool for Wi-Fi network planning and analysis. 
 
Working with a virtual model of your site, TamoGraph lets you explore signal levels, coverage quality, 
throughput, and other key performance indicators before any hardware is installed. You can experiment with 
base station parameters and layouts across a wide range of scenarios, from femtocell and picocell layers to 
denser microcell deployments in both Sub-6 GHz and mmWave bands. 
 
This beta version is particularly well suited for early design work: sketching out smaller deployments, 
comparing equipment options, and trying out different configuration ideas. Planning your network with 
TamoGraph at this stage can help shorten the initial rollout, guide you toward more suitable hardware choices, 
and reduce avoidable maintenance and upgrade costs later on. 
 

Why Use Virtual Predictive Model in Your Cell Network Design? 
 
Real on-site surveys provide data about the current radio environment at a given location. A virtual predictive 
model, by contrast, is created and adjusted entirely on your computer. In this approach, you build a 
representation of the physical environment and place simulated base stations; the software then predicts the 
resulting radio characteristics for that model. This process is often referred to as RF planning, RF predictive 
modeling, or RF modeling. 
 
When you are deploying a new network, a predictive model can substantially reduce the number and scope of 
on-site surveys you need to perform. That, in turn, helps conserve time, budget, and engineering effort. Using 
TamoGraph with a virtual model, you can quickly estimate deployment costs, evaluate multiple design options, 
and compare different equipment configurations before any purchase decisions are made. 
 
Even if the real site is not yet accessible, or is still at the design or construction stage, virtual-model-based 
planning allows you to explore how the future network is likely to behave and to refine your design while the 
project is still flexible. 
 



 

System Requirements 
 
TamoGraph requires a computer with the following minimal system requirements: 
 

• Windows 10 or 11; Windows Server 2022 or 2025. 

• Intel Core 2 or similar CPU. A multicore CPU such as Intel i5 or i7 is recommended.  

• 16 GB of RAM. 

• 400 MB of free disk space. 
 
Trial Version Limitations 
 
The trial of TamoGraph allows you to evaluate the software for 30 days and has the following limitations: 
 

• Watermarks are placed on all visualizations.    

• You cannot save projects or reports. 

  



 

Interface Overview 
 
The application main window includes the following elements: 
 

• The resizable left-side panel displays a list of base stations and radio units. 

• The central area is used for displaying the floor or site plan image and visualizations of analyzed data. 

• The resizable right-side panel allows you to manage project floor plans, as well as to configure various 
project options and settings. 

 
You can hide and show the left and right panels using the vertical splitter or through the menu commands View 
=> Left Panel and View => Right Panel. 
 
In addition to the three main elements, the application contains the main toolbar (provides quick access to 
frequently used commands), the RF Planner toolbar (used in predictive modeling for drawing virtual objects), and 
the status bar (provides information on Network Utilization and Interference level, current floor plan dimensions, 
coordinates, and zoom level, as well as the legend for the currently selected visualization). 

 
 

 
The following chapters describe the functionality of these elements in detail. 



 

Base Station List 
 

The left application panel is used to display the list of base stations during predictive modeling. You can use 
the Group by button to group base stations by standard, channel, name, duplex type, radio unit or custom 
group. Grouping by Radio Unit is the best method when modeling network in DAS environment. 
 

 
 

The list displays key base stations parameters in the corresponding columns: power in dBm, spatial streams, 
duplex type, maximum data rate in Mbps, band, PCI, channel and channel width in MHz. You can rename a base 
station by right-clicking on them and selecting Rename. To restore the original name, simply delete a user-
assigned name by hitting the backspace key. You can customize the columns by right-clicking on the list header 
or change their order by dragging them. 

 
The icons are color-coded to reflect bands and standards they use: 

 
 

 4G LTE base station 

 

 5G base station 

 

 Radio Unit (RU) 



 

The check boxes next to the base station icons play a very important role: They should be used for selecting 
the base stations you want TamoGraph to analyze. When the Selected Base Stations mode is enabled on the 
toolbar, data visualizations include only the base stations that have checked boxes next to them. 

When working with dozens of base stations, it might be difficult to find the corresponding entry on the base 
stations list for a given icon on the site map and vice versa. To help you with this task, two visual feedback 
mechanisms exist: 

 
• When you select a base station icon on the site map, the corresponding item on the list is highlighted 

in grey color. 

• When you double-click an item on the list, the corresponding base station icon on the site map blinks 
a few times (assuming that the corresponding base station icon is shown on the site map). If the base 
station icon is not within the site map’s visible area, the site map is automatically scrolled to ensure 
that the icon is visible. 

 

You can also use the Search function to find a base station by name or PCI. To do this, use the search field 
located above the base stations list and enter some text. If matches are found, they will be highlighted, and 
the selection line will be placed on the first match. To the right of the search field, you can see the total 
number of matches and the current match number. The “left” and “right” buttons can be used to navigate 
to the previous or next match. 

 
Custom Groups 

 
One of the possible base stations grouping methods is by “Custom Group”. This method might be used if you 
have a grouping criterion that is not covered by the standard grouping methods. For example, you may want 
group base stations by their location. Initially, base stations are not assigned to any group. To create groups 
and assign base stations to them, use the Custom Group menu. Under this menu, you can Add selected to 
an existing or new group (by “selected,” we mean the base stations that are currently checked in the base 
stations list) or Clear grouping for all or selected base stations. You can also Manage all groups. When you 
use the Manage command, the application displays a dialog listing all base stations and their membership in 
the groups. Initially, all base stations are marked as Ungrouped. You can create new groups, rename them, 
delete them, and move one or several base stations to any group via drag-and-drop. Note that a base station 
cannot be assigned to multiple groups; it can be assigned either to one group or to no group. Groups are 
project specific, which means that they exist only within a given project. You cannot create or manage groups 
when no project is open. 

 
  



 

Floor Plan / Site Map 
 

This central area of the application window is used to display the floor plan or site map on which the modeling 
of the site is performed by placing walls, attenuation zones, and virtual base stations: 

 

 

 
The application status bar displays the map dimensions and your current coordinates when you hover the mouse 
over the map. To zoom in our out, use the mouse scroll wheel or the Zoom button on the status bar. To pan the 
map, use the vertical and horizontal scroll bars or press and hold the space bar and drag the map while holding the 
left mouse button. If you are using a computer with a multitouch display, you can use the two-finger pinch zoom 
gesture to zoom in or out and the two-finger pan gesture to pan. 

When you are have completed modeling the site, you can use the Visualization drop-down list on the toolbar to have 
TamoGraph display data visualizations for your site (e.g., RSRP or coverage areas). 

 
Plans and Surveys, Properties, and Options Panel 
 
This panel gives you access to virtually all the application and project settings. Using this panel, you can 
manage floor plans, configure requirements for your cellular network, select color schemes for your 
visualizations, etc. For a detailed description of these functions, refer to the Configuring TamoGraph chapter. 
 

 
  



 

Main Menu 
 

The application menu commands are described below.  
Project 

 
• New – launches a new project wizard. 
• Open – opens a previously saved project. 
• Save – saves the current project. 
• Save As – saves the current project under a different name. 
• Close – closes the current project. 
• Generate Report – opens the report generation dialog. 
• Save Current Visualization – saves the currently selected visualization and legend to an image file. 
• Clear Recent List – clears the list of recently opened project files. 
• Exit – closes the application. 

 
Plan / Map 

 
• Calibrate – allows you to set the map dimensions. 

View 
 

• Left Panel – shows or hides the left panel. 
• Right Panel – shows or hides the right panel. 
• Main Menu – shows or hides the main application menu. To show it again, press ALT or use the View 

context menu on the central pane. 
• Main Toolbar – shows or hides the toolbar in the main application window. 
• RF Planner Toolbar – shows or hides the toolbar for editing virtual objects used in predictive modeling. 
• Status Bar – shows or hides the application status bar. 
• Full Screen – expands the main application window and hides all other applications. To exit full screen 

mode, press F11 or use the View context menu on the central pane. 
• Vertical Ruler – shows or hides the vertical ruler. 
• Horizontal Ruler – shows or hides the horizontal ruler. 
• Legend – shows or hides the legend on the map. 
• Base Stations – shows or hides base stations’ icons.  
• Virtual Objects – shows or hides virtual objects (walls, attenuation areas and floor areas) that were 

created as part of predictive modeling. 
• Media Objects – shows or hides icons that represent images that you added to the project. 

 
Settings 

 
• Interface Font – allows you to change the interface font. 

  
Help 

 
• Contents – displays help documentation. 
• Contents (PDF) – displays help documentation in PDF format. 
• Check for updates – connects to the TamoSoft website and checks whether a newer application 

version is available. 
• Activation – activates your registration key. 
• About – displays information about the application. 

 



 

Creating a New Project 
 

To plan an LTE/5G network for your site, you need to: 
 

• Create a new project with the help of the Project Wizard.    

• Calibrate the floor plan or site map. 
• Configure the program options and network requirements. 

• Create a virtual environment. See the chapter on modeling for more information. 

The following chapters describe these steps in detail. 

 
New Project Wizard 

 
To create a new project, click Project => New. A wizard window will appear. 

 
Step 1 

 
Specify the Name, Description (optional), and Project path. The name you give to the project is used as the file name 
under which your project will be saved in the folder specified in the Project path field. 

 
Step 2 

 
In this step, you should Select an environment. The Environment panel allows you to configure some of the 
very important project parameters that affect the way data visualizations are computed. Because different 
environments have different characteristics in terms of signal attenuation, diffraction, reflection, etc., you 
are asked to select the environment that best describes the site you plan to survey. 
 
Select the primary frequency band that will be used at your site. The program can combine base stations 
operating in different bands, but the primary band will be used by default. 
 
Finally, the Measurement units control can be used to choose the preferred units (feet or meters) for displaying 
distances and coordinates throughout the application. See the Environment chapter for more information. 

 
Step 3 

 
In the final step, you should add an image file that contains the floor plan or site map of the facility or area where you 
want to deploy your cellular network (you will be able to add more images if your project includes several zones 
or floors later.) A floor plan or site map is required for accurate data analysis. If no image file is available, you may 
want to scan a plan, if it exists on paper, create one using a drawing program, such as CorelDraw, or even make a 
sketch using a ruler and pencil and then scan the sketch (be sure to follow the proportions). The image file should be 
between 250 and 2,500 pixels on a side (naturally, this applies to raster formats only; vector images, such as DWG, 
do not have pixel dimensions). Larger images will slow down the application. The following image file formats are 
supported on Windows: BMP, PNG, JPG, GIF, WMF, TIFF, PDF, DWG, DXF, and SVG.  



 

If you add an AutoCAD image (DWG or DXF), an additional import settings dialog is displayed. This dialog allows you 
to select a layout to be used (if the file contains multiple layouts) and include or exclude specific layers. For 
example, you may want to exclude the plan legend. You can also crop the floor plan to define a specific zone to be 
used for surveying. 

The application also supports PDF files. When you use a PDF file, an additional import settings dialog is displayed. 
This dialog allows you to select a page to be used (if the file contains multiple pages). Alternatively, you 
can use any of the images embedded into the PDF file; such images are listed on a separate tab. You can also 
rotate or crop the floor plan to define a specific zone to be used for surveying. 

You can also import a map from one of the online map services. Click Load Street Map to open a new map loader 
dialog. Once the initial map view is loaded (the application will try to guess your location based on the Wi-Fi 
environment), you can navigate to the area you want to survey, using the map controls or the Navigation frame, in 
which you can enter your coordinates or your address. Click Go to Location to load the map of the corresponding area. 
When you are satisfied with the area selection and zoom level, click Use Map. Note that the application will use the 
map image as you see it, with the selected zoom level and size in pixels as in the map loader window (the window can 
be resized). Be sure to select the area correctly and to set a zoom level that meets your needs, as you will not be able 
to resize the map or zoom in/out at a later time. 

 
Calibration 

 
Once the project has been created, you will be prompted to calibrate the floor plan or site map. 

Calibration is the process by which you “tell” the application about the 
map dimensions.  
 
To calibrate the map, you need to know the distance between two points on the map. That can be the distance 
between two walls or windows. Click on the first point of the distance, and move the mouse pointer to the second 
point while holding down the left mouse button. Release the left mouse button when the mouse pointer is over 
the second point. A red line indicating the distance will be shown. At the bottom of the screen, enter the length of 
the red line and click Apply. 
 

Configuration 
 

Before you begin working on your network model, you may want to configure some of the application settings 
and project properties, although this is not mandatory. Available settings and options are described in the 
Configuring TamoGraph chapter. Specifically, it is recommended that you configure network requirements. 
This is helpful for a quick and easy evaluation of the overall health of your network and detection of potential 
issues. 

 

  



 

Modeling Your Cellular Network 
 
TamoGraph is a tool for planning and analyzing the performance of 4G/LTE and 5G/NR networks that are yet to 
be deployed at a site. To achieve this, TamoGraph uses a virtual model of the site and radio equipment to 
simulate radio coverage. This process is called “RF predictive modeling” or “RF planning” (“RF” stands for Radio 
Frequency), since the characteristics of the future network are determined according to the virtual environment 
defined by the user. The virtual model includes walls and other obstructions, as well as virtual base stations placed 
by the user. In other words, it is a computer simulation. No on-site measurements are required. 

 

Before you begin modeling, create a new project as described in this chapter if you haven’t already done so. 

To create a virtual model of the environment, the user needs to “tell” the application about the position, size, and 
type of the physical objects that affect radio wave propagation. Typically, walls and other obstructions, such 
elevator shafts, are already shown on floor plans; however, these are merely lines and dots that are meaningless to the 
application. The user has to draw such physical objects on top of the floor plan and define their characteristics. 

 

 

Before you begin, ensure that the RF Planner toolbar is visible (press the RF Planner button to unhide it). Now you 
are ready to start creating a virtual model.  

 
Simulating a cellular network is a computationally intensive process. A high-
performance multi-core CPU and/or discrete GPU are recommended for improved 
performance. 



 

It is recommended to begin by drawing walls. Once the walls have been drawn, you can place base stations 
on the floor plan, decide how many base stations you need to provide adequate coverage, select the best 
positions for them, and configure their parameters. 

Once you have completed this process, you can analyze data. If you are a novice in cellular network design, 
we also suggest that you read about Best Practices, Tips, and Tricks at the end of this chapter. 

 
Remember that the accuracy of your results depends on the data you enter into the model. Ensure that you collect 
full business and technical requirements before you begin RF modeling. Know what types and numbers of client 
devices will be used, where and what applications they will use, and whether there are any mission-critical client 
devices that you need to consider. In addition, consider possible future changes and upgrades. 



 

Drawing Walls and Other Obstructions 
 

To draw a wall or other obstructions (e.g., doors or windows) on the floor plan, press the wall drawing tool button and 
select one of the pre-defined wall types, for example “Brick wall” or “Interior office window.” You should select the 
type that best matches the actual wall you are going to draw. You can also select one of the two drawing modes: 
Line or Polygonal path. If you selected the Line mode, left-click on the floor plan to start a new wall and left-click 
once again in a new location to finish the wall. A straight line representing the wall will be drawn. If you selected the 
Polygonal path mode, left-click on the floor plan to start a new wall and left-click every time you need to start a 
new line segment. This will draw a connected series of line segments. If you hold the Ctrl key while drawing walls, 
the line is drawn in orthogonal mode (0, 90, 180, or 270 degrees). If you need to cancel the previous move, right-click 
on the shape and select Undo Last Segment in the context menu. To finish the wall, click on the last point or press 
the ESC key. You can move or resize the walls that you have drawn. To move a wall, select it and drag it with the 
left mouse button to a new position. To resize a wall or wall segment, select it, move the mouse over the vertex 
(shown as a white circle), click on it, and drag it with the left mouse button to a new position. 
 
Please note that there is no need to redraw similar obstructions manually; you can simply copy and paste 
objects individually or in groups. For example, you can copy a set of walls, doors, and windows from one 
room and paste it to another. See Copying, Pasting, and Deleting Multiple Objects for more information 

After the wall has been drawn, you can change its properties in the Obstruction Properties dialog. To display this 
dialog, double-click on a wall or select the Properties context menu item. In the dialog window, you can 
change the obstruction type by selecting one of the existing presets or modify obstruction characteristics such 
as attenuation, reflection, or color. Attenuation is a drop in strength measured in dB that the RF signal experiences 
when it passes through the obstruction. Because materials might attenuate differently at different frequencies, you 
may need to specify the obstacle material properties for other frequency bands. Note that by default, the material 
characteristics are defined using the frequency of the project’s selected main band (Main band). You can change the 
project’s main band in the Properties -> Environment panel. You can enter a custom attenuation value. Reflection is a 
percentage of signal strength that is reflected by the obstruction at the 90° angle. Color is an arbitrary color used to 
show the obstruction on the floor plan. If you prefer obstructions to appear colorless (i.e., grayscale), you can 
configure the application to grayscale them in the Visualization Settings panel. When you have edited obstruction 
properties, you can save the current configuration for future use by clicking the Save as Preset button at the bottom 
of the dialog window. 

You can also select an existing preset, modify it, and click Save to save it under the same name. To save it under a 
different name, change the preset name before clicking Save. Click New to create a new preset from scratch. To 
delete an existing preset, click Delete. 

Consider creating separate custom presets for each wall or door type in your project even if they match existing 
presets. This allows you to change the values or colors of all similar objects with a few clicks, as shown below: 



 

 

 
Drawing Attenuation Zones 

 
An attenuation zone is an area where the signal strength drops over distance. This makes it different from 
walls and other obstructions, where the drop occurs only one time, when the signal passes through a specific 
object, and where the object thickness is negligible. To draw an attenuation zone on the floor plan, press the 
attenuation zone drawing tool button and select one of the pre-defined attenuation zone types; for example 
“Elevator shaft” (there is also a zone type titled “Floor Area” that is not an attenuation zone per se; we will 
talk about this in the  Working with Multi-floor Sites chapter). You should select the type that best matches 
the actual attenuation zone you are going to draw. You can also select one of the two drawing modes: 
Rectangle mode or Polygon mode. A rectangle is defined by its top left and bottom right corners; it is aligned 
vertically/horizontally and cannot be rotated. Polygons consist of multiple line segments, allowing more 
complex shapes to be created. If you selected Rectangle mode, left-click on the floor plan to start a new zone, 
drag the mouse to form a rectangle, and release the left mouse button to finish. If you selected Polygon 
mode, left-click on the floor plan to start a new zone and left-click every time you need to start a new line 
segment. This will draw a connected series of line segments. If you hold the Ctrl key while drawing, the line 
is drawn in orthogonal mode (0, 90, 180, or 270 degrees). If you need to cancel the previous move, right-click 
on the shape and select Undo Last Segment in the context menu. To finish the zone, click on the last point, 
or press the ESC key, or click Done on the info panel below the floor plan. You can move or resize the zone 
borders that you have drawn. To move a zone, select it and drag it with the left mouse button to a new 
position. To resize a zone or zone segment, select it, move the mouse over the vertex (shown as a circle), 
click on it, and drag it with the left mouse button to a new position. 

After the zone has been drawn, you can change its properties in the Attenuation Zone Properties dialog. To 
display this dialog, select a zone and double-click on it, or select the Properties context menu item. In the 
dialog window, you can change the zone type by selecting one of the existing presets or modify zone 
characteristics such as attenuation or color. Attenuation is a drop in strength measured in dB per meter (or 



 

foot, depending on the measurement units of your project) that the RF signal experiences when it moves 
across the zone. Because materials might attenuate differently at different frequencies, you may need to 
specify the obstacle material properties for other frequency bands. Note that by default, the material 
characteristics are defined using the frequency of the project’s selected main band (Main band). You can 
change the project’s main band in the Properties -> Environment panel. You can enter a custom attenuation 
value. Color is an arbitrary color used to show the zone on the floor plan. If you prefer zones to appear 
colorless (i.e., grayscale), you can configure the application to grayscale them in the Visualization Settings the 
panel.  When you have edited zone properties, you can save the current configuration for future use by 
clicking the Save as Preset button at the bottom of the dialog window. 

As with the material presets, you can select an existing preset, modify it, and click Save to save it under the 
same name. To save it under a different name, change the preset name before clicking Save. You can also 
click New to create a new preset from scratch. To delete an existing preset, click Delete. 

 
Copying, Pasting, and Deleting Multiple Objects 

 
While working on your RF model, you can copy multiple virtual objects and paste them to the current or a 
different floor plan. To select multiple objects, hold the Ctrl and left-click on each object you would like to 
add to the selection. Another click on the selected object removes the selection from the given object. 
Clicking anywhere outside the selection unselects all objects. Alternatively, multiple objects can be selected 
by drawing a frame, i.e. pressing and holding the left mouse button and dragging the mouse. 

If multiple objects of different type are selected (e.g., base stations, walls), an additional panel is displayed 
below the floor plan. Using the checkboxes on that panel, users can control which type(s) of objects should 
be included in the selection. By default, all types of objects are included. 

Once the objects have been selected, you can copy them to clipboard by pressing Ctrl + C or by using the Edit 
=> Copy context menu item. Copied objects can be pasted to the same floor plan, a different floor plan within 
the same project, or even to a floor plan in a different project. To paste objects, use Ctrl + V or the Edit => 
Paste context menu item. You may need to adjust the pasted objects’ positions after pasting. 

To delete multiple objects, select them as described above and press the Del key. 

 
Undo and Redo 

 
TamoGraph keeps track of all the changes that you make to your RF model as you work. This allows you to 
roll back your model to any previous state within the current editing session. This function is useful if you 
make a mistake and want to undo a certain action. 

  



 

To access this functionality, you can use the Redo last operation and Undo last operation buttons on the RF 
planner toolbar. These buttons contain drop-down menus that list all previously performed editing 
operations. You can also use the context menu commands, Edit => Undo and Edit => Redo, as well as the 
keyboard shortcuts: Ctrl + Z and Ctrl + Y. 

 
Placing and Configuring Base Stations 

 
To place a base station on the floor plan, press the base station drawing tool button and select one of the 
pre-defined base station types; for example, “Generic 5G NR” or “Generic Cat.A LTE Adv.” Click on the floor 
plan to place a base station in a desired location. After that, you can change its properties by double-clicking 
on the base station or by selecting the Properties context menu item. The Base Station Properties dialog can 
be used for loading base station characteristics from one of the presets, assigning a unique name to a base 
station, or for customizing base station characteristics. 

To customize a base station, you can use two Radio tabs. Both radios can be either configured independently 
and use different standard and bands, or share the same band and/or standard. These tabs allow you to turn 
on and off these radios independently (using the Radio enabled check box) and configure the following 
characteristics for each of the two radios: 

• Standard. Use this drop-down list to select one of the cell network standards. 

• Band. Choose the appropriate frequency band that will be used by this radio. 

• Tx Power. Opens the drop-down list for selecting the base station transmit power. The typical power 
of LTE base stations usually falls within the 20–30 W range. 5G base stations have a much wider range 
of power levels — from a few hundred milliwatts for small cells up to 120 W for large macro cells 
installed on outdoor towers and using MIMO antenna arrays. Since the transmit power depends 
heavily on the specific equipment used, refer to its documentation to set this parameter correctly. 

• Channel Width. This parameter defines the channel width, and the available values depend on the 
selected Standard and Band. For LTE, the maximum available width is 20 MHz. For 5G, carrier 
aggregation can provide channel widths of up to 100 MHz in Sub-6 GHz bands and up to 400 MHz in 
the mmWave band. 

• Subcarrier Spacing. Defines the subcarrier spacing in kilohertz. For LTE, this value is fixed at 15 kHz. 
For 5G, seven possible values are used depending on the selected frequency band. In the mmWave 
range, a spacing of 120 kHz or higher may be required. 

• CID. Cell ID, a unique identifier of a specific cell on a cellular network. 

• TX/RX Streams. Allows you to select the number of MIMO streams that can be used for transmission 
(TX) or reception (RX) by the base station equipment. 

The Duplex Mode frame allows you to set a number of parameters the availability of which depends on the 
duplex mode for the given band: Frequency Division Duplex (FDD) or Time Division Duplex (TDD). This frame 
includes the following controls: 

• DL/UL Configuration (available for TDD only). Sets the pattern that defines which symbols/slots are 



 

used for downlink, uplink, or flexible. The available values are 0-6 for LTE and 0-55 for 5G. 

• DL/UL Channel (available for TDD only). Sets the channel number to be used. 

• Flexible Symbol Policy (available for 5G TDD only). Defines what flexible (F) slots are used for. 

• Subframe Configuration (a.k.a DwPTS–GP–UpPTS configuration, available for LTE TDD only). It 
defines how Subframe 1 is split between DwPTS, GP, and UpPTS. 

• DL Channel, UL Channel (available for FDD only). Sets the downlink (RX) and uplink (TX) channel 
numbers to be used. 

 
The PCI frame allow setting the PCI identifier that is calculated using the formula PCI = (3 x SSS) + PSS, where: 
 

• PSS (Primary Synchronization Signal) – the synchronization signal used for the initial detection of the 
base station. The value range is 0–2. 

• SSS (Secondary Synchronization Signal) – used for final synchronization and obtaining the full cell 
identity. The value range is 0–335. 

 

The Advanced 5G Settings frame allows setting some additional parameters of 5G networks: 

• SSB (Synchronization Signal Block) Beams. Sets the number of directional broadcast beams that carry 
synchronization and system information (the SSB). 

• Max. phased array beamforming gain. This parameter defines the signal gain achieved by using 
multiple antennas as a single phased array. The gain is directly dependent on the number of antennas 
used. Typical values for base stations in the Sub-6 GHz range are 8–10 dB. For mmWave, the gain can 
reach up to 22 dB. Experimental prototypes in this range demonstrate a gain of 26 dB when using a 
32×10 array. Leave the value at 0 dB if this technology is not used. 

• 3GPP 38.306 scaling factor. Set the multiplier used for calculating a User Equipment's maximum data 
rate. It accounts for the difference between the maximum supported number of MIMO layers and 
modulation order and the actual configuration, ensuring a more realistic average data rate is calculated 
for a given band or band combination. It can take values of 1, 0.8, 0.75, and 0.4.  

• 3GPP 38.214 table. Sets the specific MCS table to be used. 

 

The Antenna frame Use this frame to specify the kind of antenna used by the base station. The Select button opens the 
antenna selection dialog (overviewed below). With the Rotation control, you can specify the angle (in degrees) relating 
to the horizontal positioning of the antenna. With the Elevation control, you can specify the angle (in degrees) above 
the horizon, i.e., the angle by which the antenna is tilted up or down in relation to the theoretical horizon. With the Tilt 
control, you can specify the angle (in degrees) relating to the vertical axis, i.e., the angle by which the antenna is 
tilted sideways. The Height control can be used to specify the height of the base station above the floor level. The 
Advanced dialog provides top, front, right, and 3D views of the selected antenna diagram and can be used to adjust 
the antenna orientation either by rotating the diagram top, front, or right views or by entering numeric values. 

 

When you have edited base station properties, you can save the current configuration for future use by clicking 



 

the Save as Preset button at the bottom of the dialog window. 

 

Antenna Selection 

 
When you click Select in the Antenna frame, an antenna selection dialog is displayed. Using this dialog, you 
can choose from a variety of antenna models by a number of cellular network equipment vendors or one of 
the generic antenna types. Each listed antenna has a name, vendor name, and gain. By default, the available 
antennas are grouped as follows: 

 
• Recently Used – antennas that you have recently used in your projects. Initially, this group is empty. 
• Generic Antennas – standard antenna types that are not associated with a specific vendor. 
• Vendor Antennas – antennas manufactured by major cell network equipment vendors. 

 
Checking the Group by Vendor checkbox re-groups the list by vendor name. You can use the Quick search field 
to find antennas that match the search string. Note that the search is performed only for vendor antennas; 
recently used and generic antennas are always displayed. 

Advanced users may want to add their own antenna patterns or edit existing ones by clicking the New antenna 
and Edit current antenna buttons, respectively. This will open the AntEditor utility. Please note that this is an 
experimental tool, and we do not provide official support for it. Please watch Using TamoSoft Antenna Editor 
to learn how to use this utility. 

In addition, if you want to add a new antenna pattern for a specific base station and you cannot or do not want 
to do this yourself, just contact our technical support and we will add your antenna pattern to TamoGraph in 
a matter of days. Just ensure that the antenna radiation patterns (in graphical or numerical format) are publicly 
available (or available to you, in which case you should send them to us). 

 
Adjusting Horizontal Antenna Orientation 

 
Once a base station has been placed on the floor plan, you can change its horizontal antenna orientation 
without opening additional dialogs. To do that, select a base station with a mouse click; you will see a ring that 
surrounds the base station icon and a triangle-shaped marker that shows the direction of the antenna’s main 
lobe. To modify the direction, hover the mouse over the triangle and, while holding the left mouse button 
pressed, drag the triangle to change the antenna’s main lobe direction. 

Naturally, this operation is advisable only if you are working with directional antennas, such as sector antennas. 
For omnidirectional antennas, rotating the antenna is not needed at all. 

 
Creating Vendor-Specific Base Station Presets 
 
As described in the previous chapter, TamoGraph allows for full customization of all virtual base station 
parameters. This functionality makes it possible to create virtual station presets that match actual hardware 
from major cellular equipment vendors. 

 

https://www.youtube.com/watch?v=ZEVsnArIwL0


 

Before we explain this procedure, we would like to answer one of the most frequently asked questions: 

 
Why do you not add vendor-specific base station presets yourselves? 
 
Indeed, TamoGraph includes only a few generic base station presets, because real-world hardware has many 
configurable parameters and only you know how your base station is or will be configured. It is impossible to 
cover the full variety of base station parameter configuration combinations in ready-made presets. Therefore, 
you, the network administrator, should create unique base station presets in accordance with your unique 
configurations. This is very easy. All base station presets consist of two parts: 

 

1. Base station configuration parameters (power, channel, installation height and angles, etc.) 

2. Antenna preset. 
 
This can be expressed by a simple formula: 
 
Base Station Preset = Base Station Parameters + Antenna Preset 

Yet another reason we do not add vendor-specific base station presets is that many outdoor base station 
models do not have integrated antennas. Instead, the user can select from a number of external antennas, 
which means that the same base station model may have multiple antenna options and, therefore, multiple 
presets. 

To illustrate the process, suppose we want to create a preset for an indoor small-cell base station — for 
example, something like the Microamp CellBox Lite 5G operating in the mmWave band. First, click on the 
Virtual Base Stations button on the toolbar and select Manage / Create New Presets: 

 

 
This opens the Preset Manager where you can modify all the base station parameters and change the 
antenna type. Select the Generic 5G NR High-band cell as the base on which we are going to build a preset 



 

for the specific base station. The screenshot below illustrates a few changes we made to the default values 
for the radio to ensure that the virtual base station matches the real-world CellBox Lite 5G that we plan to 
deploy: 
 
 

 

 
The following changes have been made: 
 

• The Preset Name is changed to CellBox Lite 5G. 
• The Tx Power set to 24 dBm. 
• The channel width was set to 400 MHz according to specs. 

 
To finish creating the preset, use Select… to choose an appropriate antenna. The program includes a large 
database of external antennas, primarily those used for outdoor deployments. In this case, our base station has 
a built-in antenna system that can be modeled by selecting the standard Generic Patch 9 dBi antenna. For base 
stations that use external antennas, you can choose the required model from the list provided, grouped by 
manufacturer: 



 

 

 
If you cannot find a matching antenna, please refer to Antenna Selection, which lists a few options available 
to users. 

You may want to click Advanced… to examine 3D views of the selected antenna diagram and to adjust the 
antenna orientation either by rotating the diagram views or entering numeric values. 

Finally, clicking OK confirms the antenna selection.  

Clicking Save saves the new preset. The preset is now available alongside the generic presets in the drop- 
down list. Managing base station presets is similar to managing walls or attenuation zone presets. You can 
select an existing base station preset, modify it, and click Save to save it under the same name. To save it 
under a different name, change the preset name before clicking Save. You can also click New to create a new 
preset from scratch. To delete an existing preset, click Delete. 

  



 

DAS and Placing a Radio Unit (RU) 

A Distributed Antenna System (DAS) is a network of antennas or RRUs (Remote Radio Units) connected to a 
single signal source (such as a mobile operator’s base station) and deployed throughout a facility—such as a 
building, stadium, or airport—to distribute radio coverage evenly. This topology offers several significant 
advantages over traditional networks, including: 

• Improved coverage and signal quality. Especially important inside buildings, in dense urban areas, 
underground structures, elevators, and parking garages. It eliminates “dead zones” where a standard 
operator signal is unavailable. 

• High capacity. Supports a large number of simultaneous device connections without degrading 
performance. 

• Flexible placement. Antennas can be positioned exactly where signal enhancement is needed, 
enabling flexible coverage design. 

• Scalability. The system can be easily expanded as coverage requirements or facility size grow. 

If your planned network uses any type of DAS architecture, you can model such a system in TamoGraph. To 
do this, add RU devices to the virtual model and place them on the map or floor plan. Click the arrow on the 
Virtual Base Stations button on the toolbar and choose Radio Unit. This activates RU placement mode, and 
by clicking on the map you can place one or more Radio Units. 

When you are done placing Radio Units, click on the arrow button on the toolbar to finish the placement process. 

You can then connect the previously placed base station units to specific RUs. To do this, right-click the 
desired RU and select Add/Remove RRU… The program will switch to the RRU add/remove mode. Then click 
on the base stations located near the RU to connect them. In this way, a base station connected to the RU 
becomes one of its Remote Radio Units in DAS terminology. Clicking the station again disconnects it from 
the RU. 

For base stations connected to an RU, the program displays the possible cable routing path and calculates 
the minimum required cable length. Two cable-length calculation methods are available: Shortest route 
(straight line) and Orthogonal (routing along walls). You can choose the calculation method in Properties → 
Environment → Cable laying method. In the same panel, you can enable or disable Cable length control. This 
function prevents connecting stations to an RU if they are located farther than the maximum allowed cable 
length. 

You can configure the maximum cable length and the maximum number of RRUs that can be connected in 
the properties of a Radio Unit. To do this, right-click the desired RU and select Properties. In the dialog shown 
below, you will also be able to rename the radio unit and check or uncheck the Enabled box. Unchecking the 
box excludes all the connected RRUs from visualizations. 



 

 
 

Working with Presets 
 

Presets are pre-configured sets of values for base stations, walls, and attenuation zones (and, additionally, 
for floors/ ceilings, if you work with multi-floor sites). Presets can be accessed via the Manage Presets menu 
item available in the corresponding drop-down menus for each of the three object types. At the top of the 
preset management dialog, you can see a drop-down list populated with existing presets. You can select an 
existing preset, modify it, and click Save to save it under the same name. To save it under a different name, 
change the preset name before clicking Save. You can also click New to create a new preset from scratch or 
delete an existing preset by clicking Delete. 

Working with Multi-floor Sites 
 

When a cellular network for a multi-floor building is being designed, the virtual model must take into 
consideration signal “leak” from the adjacent floors. This is important for two reasons. First, it is a common 
practice to provide connectivity to the adjacent floor by means of the base stations that are deployed one 
floor below or above. Second, if providing connectivity by this method is not planned, it is important to make 
sure that the signal that penetrates the floors does not cause interference. With TamoGraph, you can create 
and analyze multi-floor models as explained below. 

 
Creating a Multi-floor Project 

 
To create a multi-floor project, you should first follow the same steps that you follow to create a standard 
project; you must add a floor plan to the project and calibrate it. You can begin with the first floor. Once a 
standard project with a single floor plan has been created, you can use the Plans and Surveys tab on the right 
panel to manage floors and define their characteristics. Floors define the building’s vertical structure. Floor 
maps within each floor contain images of the floor plans. Click Add => Floor to create a new floor level. If this 
is the first time you have added a floor to the project and the project already contains previously added floor 
plans, you will be prompted to move the existing floor plans to the newly created floor. You can also do this 
later, by dragging the floor plans to the new floor. 



 

After that you can click Add => Floor again to create a new floor level. If the floor plans are identical for all the 
floors in your model, you can duplicate floors after drawing walls and other obstructions on the first floor plan 
and placing alignment points; this is described in detail below. If the floors are not identical, you should add 
individual floor plans images in one of the supported graphic formats for every floor by selecting the 
corresponding floor and using the Add => Plan… command. New floor plans must then be calibrated. Note that 
for each floor, you can add multiple floor plans that might have different scale and orientation. 
 
Once the floors have been created and the corresponding floor plans have been added and calibrated, you 
should specify floor heights and a few other characteristics. New floors are added with default floor materials 
and heights; to specify correct values for your building, right-click on any of the floor items and select 
Properties or click on the Floor Manager button. You can also use this dialog to rearrange floors. 
 
Use the Add Roof button to add a roof on top of all floors. You can specify the material reflection and 
attenuation of the roof in the Floor/Ceiling Properties window accessible via the Modify… button. Once you 
have defined the floor and roof properties, address floor plan alignment as explained below. 

 
Aligning Floors 

 
When you work with a multi-floor site model, TamoGraph can analyze radio signals that come from the 
adjacent floors. To be able to take advantage of this functionality, you need to perform floor alignment. Floor 
plan alignment is necessary because floor plans might have different scale, orientation, or offset. While floor 
alignment is not mandatory, TamoGraph will use only the data from the current floor unless you perform 
floor alignment. To perform it, please do the following: 
 

• Right-click on the first-floor plan and select Align Floor Plan. 

• Choose a few locations on the floor plan that will be easily identifiable on the plans of other floors. 
This could be elevator shaft corners, building corners, staircase corners, or anything else that you can 
easily find on all the floor plans that you use in the project. 

• Click Add point to place a new marker on the floor plan, and then move the marker to one of these 
locations. Create at least two markers. Each marker is assigned a unique number. If you made a 
mistake, click Delete point or Clear all. 

• Once you have placed two or more alignment markers, click Apply. 

• Repeat this operation for all the floor plans that you would like to have aligned. The markers must 
be positioned exactly below or above the corresponding markers on the adjacent floor. For example, 
if marker #2 on the 5th floor is placed in the bottom right corner of the building, marker #2 must be 
also placed in the bottom right corner of the building on the floor plan of the 6th floor. 

 

To check the current floor alignment status, select Properties or click on the Floor Manager button. The 
floors that are properly aligned are marked with a green checkbox. The floors that have not been aligned yet 
are marked with a yellow exclamation mark. Just like map calibration, floor alignment must be done only 
once. 



 

 
Floor Duplication 

 
If the floor plans are identical for some or all the floors in your model, you can simply right-click on the first 
floor and select Duplicate Floor to create a copy of the first floor with exactly the same floor plan. If the walls 
and other obstructions, their placement, and materials are identical for all floors, you can calibrate a single 
floor plan, draw walls, perform floor alignment as described above, and then use the Duplicate Floor 
command; that way, you will not need to recreate the same virtual floor model for every floor or align the 
floors, because duplication includes the walls and alignment points. You can select which object types should 
be copied to the new duplicate. By default, all objects except base stations will be copied. 

 
Dealing with Complex Floor Structures 

 
When you use a floor manager to specify the materials that separate floors, you assume that each floor is a 
contiguous piece of material that covers the entire floor plan area. However, there are cases that are more 
complex. For example, one can find buildings that have “holes” in the floors that span one or several stories. 
To deal with such virtual models, you should use the “Floor Area” drawing tool; it is grouped together with 
attenuation zones and can be found in the corresponding drop-down list on the RF Planner toolbar, next to 
the “Elevator shaft” or “Filing cabinet” items. Floor areas are drawn just like other attenuation zones, using 
Rectangle or Polygon mode. As soon as you have drawn the first-floor area on a given floor, the application 
will assume that the floor has a non-standard geometry and only those areas that are covered with “Floor 
area” contain floor material; areas that are not covered are considered free from any obstructions. 

To avoid unnecessary clutter, floor areas are hidden by default. Their visibility can be turned on and off in the 
View => Virtual Objects => Floor Areas menu. We recommend hiding floor areas once you have completed 
the design of your virtual model. Additionally, for the sake of clarity, it should be mentioned that when you 
edit floor areas, you are editing the floor below your feet, not above your head. It should also be mentioned 
that the floor material and its properties are configured on the Floor Manager, as discussed in the previous 
chapters. 

 
Zero Attenuation Obstruction Material 

 
A special radio-transparent floor/ceiling material can be assigned to a floor to create additional levels where 
you need to visualize coverage but that do not have a physical floor or ceiling. Such levels can be useful when you 
have obstructions like storage shelves or partial walls whose height is lower than the ceiling, or when you need 
to analyze coverage at multiple levels above the floor in a tall warehouse. 
 

 
Multi-floor Site Data Analysis 

 
Data analysis for multi-floor sites is similar to data analysis methods for single-floor predictive models; they 
are described in the Analyzing Data chapter. However, there are some peculiarities that should be noted. In 



 

addition to the signals from the base stations located on the floor being analyzed, TamoGraph will also analyze 
the signals that penetrate from the base stations located on the adjacent floors, taking into account their 
position, height above the floor, and the material of the ceilings. The base stations located on the adjacent 
floors are displayed on the base stations list (the left pane of the main TamoGraph window), but the names of 
such base stations are shown using a light gray font color. This allows you to identify the base stations that do 
not belong to the current floor. Note that you cannot change the properties of such base stations or delete 
them. If you want to change properties of a base station or delete it, first select the floor to which it belongs 
using the Plans and Surveys tab. 

 
Best Practices, Tips, and Tricks 

 
Designing cellular networks is a complex task that requires a solid understanding of the underlying 
technologies and design principles. That said, we would like to highlight a few simple guidelines and practical 
tips. This list is not intended to be comprehensive.  
 

• Setting the base station’s maximum available transmit power is not always justified. You should 
consider not only the capabilities of the base station itself, but also those of the client devices that 
will connect to it. These may be limited, low-power devices whose weak uplink signal the base station 
will not be able to receive reliably. Even if such devices can hear the base station well, stable 
communication will still be impossible. Another important factor is signal leakage beyond the 
intended service area. Excessive transmit power may be wasted “lighting up” adjacent sectors or 
even areas served by completely different networks, where your coverage is not planned. This does 
not improve the performance of your own network; on the contrary, it harms neighboring systems 
by creating unnecessary interference. Therefore, power selection should always be thoughtful and 
justified. 

 

• Remember that even if your particular deployment prioritizes coverage over performance, channel 
selection still matters. A base station may only be able to output maximum power on specific 
channels—typically those near the center of the band. 

 

• Although RSRP provides a more accurate picture of signal quality than RSSI, it does not, by itself, fully 
describe the network’s quality or availability. This metric primarily reflects signal penetration and can 
be reported down to –140 dBm. However, the actual communication quality is determined largely 
by the signal-to-noise ratio, and in most cases, you will not achieve stable service where RSRP is 
below –110 dBm. When analyzing the network, make sure to use additional visualizations, such as 
SINR to assess interference, and Uplink/Downlink Rate to evaluate performance in conjunction with 
the selected client equipment. 

 

• It is common practice to deploy base stations with multiple radios operating in different bands, and 
TamoGraph can model such configurations. When placing them on the plan and using visualizations, 
ensure that you select the intended stations for display. With equal transmit power, a radio operating 



 

in a lower-frequency band will have wider coverage. Since most visualizations display the strongest 
base station, the signal from a second radio configured for a higher-frequency band may not appear 
on the map. To evaluate the coverage of radios operating in higher-frequency bands, temporarily 
exclude the others from the visualization. 

 

• If in doubt, you can create several copies of the same floor using different base stations and antenna 
models and see which results best suit your requirements and budget. 

 



 

Analyzing Data 
 

When you have created a virtual environment model, the application is ready to display a number of network 
data visualizations that will help you determine important characteristics of your cellular network, such as signal 
coverage, and detect potential performance problems. 

 
Selecting Data for Analysis 

 
Three key interface elements affect what data will be analyzed and how. These elements are overviewed below. 

The Plans and Surveys tab on the right panel defines what data the application will visualize. This tab is 
organized as a hierarchical tree. First of all, you need to select the floor plan to be analyzed. This floor plan 
will be displayed in the central area of the program, and you will be able to overlay various visualizations on 
it. You can add a custom comment to each plan or map, which will be shown in the Comments column of the 
tree.  

The Visualization drop-down box on the toolbar defines what type of analytical tool will be applied to the 
selected site plan. A visualization is a graphical representation of cellular network characteristics displayed 
as an overlay on top of the floor plan. The available visualization types will be described below. To select a 
visualization, simply select the corresponding item from the drop-down list. To clear all visualizations, select 
None. 

The Selected Base Stations / All Base Stations buttons on the toolbar, along with the base station list, 
determine which subset of listed base stations is used for visualizations. The default mode is Selected Base 
Stations, in which TamoGraph analyzes only the signals originating from the base stations you selected in the 
list on the left panel. 

 
Base Station Rank and Secondary Coverage 

 
Modern cellular networks are usually designed to meet stringent capacity, flexibility, and fault tolerance 
requirements. One of the most widely used methods of ensuring fault tolerance and, at the same time, 
increasing capacity, is providing secondary coverage.  In 5G networks, this is often a 4G connection that acts 
as a secondary node alongside a primary 5G node, providing wider coverage and control while the 5G node 
adds capacity. Base stations are positioned so that in case of failure or overload, no client is left without 
connection, as nearby base stations can service the zone. An additional benefit is fast and more reliable 
roaming. 

To facilitate analyzing non-primary coverage, TamoGraph offers the Base Station Rank selector that can be 
found on the application main toolbar. By clicking the Base Station Rank button, you switch the visualization 
from the primary coverage (the strongest base station) to the secondary (the second strongest) and then to 
the tertiary (the third strongest) coverage. For example, to see the signal level provided by the second-
strongest base station in a given location, you need to select the RSRP visualization and click the Base Station 
Rank button once, so that the square “2” is highlighted. If you click the Base Station Rank button repeatedly, 
the rank is switched cyclically, i.e. 1-2-3-1…, and so on. If you need to select a specific rank without going 
through the full cycle, use the menu that can be invoked by clicking on the arrow to the right of the button. 



 

 

Visualization Quality 
 
You can control the Visualization quality by using the corresponding control on the toolbar. Visualization 
quality is an important parameter that defines how precise the calculations are. High-precision calculations 
come at a cost: the higher the precision, the longer the computation time. The application offers four quality 
presets: Low, Medium, Good, and Best. They differ in grid size and in applying advanced RF propagation 
effects, such as reflection and Fresnel zones. We suggest that you use low or medium visualization quality 
while you design your cellular network and make adjustments to your design. When the design is ready, you 
can use good or best visualization quality for the final verification and/or report generation. 

 

 

 

Visualization Types 
 

The following chapters describe different visualization types and the configuration settings that affect them. 
They will also help you interpret the data and suggest solutions to problems with cellular network coverage 
and performance. 
 

Understanding Difference Between SS and CSI Visualizations 
 

For analyzing 5G networks, two sets of RSRP, RSRQ, and SINR visualizations are 
available: SS and CSI. The SS (Synchronization Signal) set applies to the broadcast 
synchronization signals from a cell, used for initial cell discovery and basic mobility. In 
contrast, the CSI (Channel State Information) visualizations apply to CSI-RS, which are 
more flexible and configurable signals used for advanced features such as beam 
management and accurate throughput estimation, as they can be adapted to reduce 
interference. Essentially, SS is a general indicator of a cell’s signal, while CSI provides a 
more specific, quality-focused measure of the channel. 
 
For 4G networks, there are no separate SS and CSI metrics; i.e. there is only one RSRP 
rather than SS-RSRP and CSI-RSRP. So the “SS-RSRP/RSRP” visualization displays SS-
RSRP for 5G networks and RSRP for 4G networks. 
 
 

 
  

 
Calculating RF propagation is a very CPU-intensive task that might take a long time for 
large floor plans with many base stations. A high-performance multi-core CPU and/or 
discrete GPU are recommended for improved performance.  It is also recommended 
that you split large floor plans into smaller parts if computing visualizations takes too 
long. 



 

RSRP 
 

RSRP, or Reference Signal Received Power, is a measure of the power of the reference signal from a cell tower 
in cellular networks. It indicates the strength of the signal received by a device and is measured in dBm, where 
a higher number (closer to zero) means a stronger signal. A higher RSRP leads to better network quality, 
faster speeds, and a more stable connection. 
 
Higher value means better service quality. A value closer to -44 dBm or above is a very strong signal, while a 
value closer to -140dBm is a very weak signal. 

Signal strength is affected by the distance: The closer the measuring point is to a base station, the stronger 
the RSRP will be. Obstructions such as buildings, trees, and other physical obstacles can weaken the signal, 
leading to a lower RSRP. A higher number of users on the network (high network load) can also impact signal 
quality. 

Double-clicking on the RSRP legend on the status bar allows you to configure the color scheme and change 
its value range. 

 
Suggested Solutions 

 
When low signal areas are discovered, the following solutions are suggested: 
 

• Change base stations’ locations: You should minimize the number of obstructions between the base 
station and the low RSRP zone. Additionally, the material of the obstructions plays an important role; 
for example, the attenuation factor of a brick wall far exceeds that of a cubicle wall or window. 

• Add more base stations: Sometimes repositioning base stations does not provide the desired effect, 
and the option becomes installing additional base stations in the problematic areas. 

• Use a different antenna: A high-gain antenna (if your base station supports the use of such antennae) 
directs radio signal in the desired direction, thereby increasing the signal level in some zones and 
decreasing it in the others. 

• Increase output power: Adjust the power output of base station radio if possible. 

RSRQ 
 

RSRQ, or Reference Signal Received Quality, is a cellular signal metric that measures the quality of the signal, 
indicating the level of interference and noise relative to the desired signal from the cell tower. It is calculated 
using the received signal strength from the reference signal (RSRP) and the total received signal power (RSSI). 
It is measured in decibels (dB), with values closer to 0 dB representing a higher quality and stronger signal, 
while more negative values indicate poorer quality. An excellent RSRQ is typically greater than -10 dB, while 
a poor RSRQ is less than -20 dB and can lead to connection loss.  
 
While RSRP measures signal strength, RSRQ provides a more complete picture by factoring in interference 
and noise from neighboring cells and other sources. 
 
Double-clicking on the RSRQ legend on the status bar allows you to configure the color scheme and change 



 

its value range. 
 
Suggested Solutions 

 
To improve low RSRQ, you either clean up interference (tilt, power, azimuth, reuse, extra sites) or relieve 
load (offload traffic, add capacity) so that the UE sees a strong serving signal with less “garbage” in the same 
bandwidth.  
 

• Reduce interference from neighboring cells. Interference is the most common cause of poor RSRQ. 
Improve it by adjusting antenna tilts or azimuths so sectors do not overshoot or overlap aggressively. 
If a particular sector is the dominant interferer, slightly reducing its transmit power can noticeably 
clean up RSRQ in the affected area. Using different carriers or bands for congested or overlapping 
sectors also helps. 

• Fix coverage holes and imbalanced footprints. Poor RSRQ often appears where coverage is weak and 
the UE is “hanging on” to a far cell. Adding small cells, indoor systems, or repositioning antennas 
gives users a stronger, cleaner serving signal.  

• Reduce cell load and PRB utilization. Even with good RF design, high utilization in a cell degrades 
RSRQ because the UE sees more interference across the full bandwidth. 

 
 

SINR 
 
SINR, or Signal-to-Interference-plus-Noise Ratio, is a cellular metric that measures the quality of a received 
signal by comparing its power to the combined power of all interfering signals and background noise. A higher 
SINR value indicates a stronger, clearer signal and better data speeds, while a low or negative value (below -
10) suggests that the signal is poor or nonexistent, leading to slow speeds and potential disconnections. This 
is calculated as the ratio of the desired signal power (S) to the sum of interference power (I) and noise power 
(N). 
 
SINR directly affects achievable data rates. It tells you how well the UE can decode data, factoring in both 
signal and interference. 
 
Double-clicking on the SINR legend on the status bar allows you to configure the color scheme and change 
its value range. 
 
Suggested Solutions 
 
When low SINR areas are discovered, consider the following: 
 

• Increase Signal Strength: Proper antenna positioning, deploying additional cells, and boosting 
transmit power can enhance the desired signal. 

• Reduce Interference: Use interference management techniques (e.g., ICIC, beamforming, 
interference cancellation), optimize network planning, and reduce cell overlap. 

• Reduce Noise: Implement noise reduction strategies and optimize power control to minimize 



 

environmental noise. 

• Advanced Antenna Systems: Utilize MIMO, beamforming, and adaptive antenna systems to improve 
spatial separation and reduce interference. 

 

CQI 
 
CQI stands for Channel Quality Indicator, a value reported by a user's device to a cellular network's base 
station to describe the quality of the wireless channel. This feedback helps the base station optimize data 
transmission by selecting the most efficient modulation and coding scheme (MCS) to balance speed and 
reliability. A higher CQI value signifies better channel quality and allows for a higher data rate, while a lower 
value indicates poorer conditions that require more robust, but slower, transmission settings. 
 
The UE converts this quality into a specific CQI value, typically on a scale from 1 to 15. CQI is crucial for 
optimizing data throughput and reliability in modern cellular systems. 
 
Double-clicking on the CQI legend on the status bar allows you to configure the color scheme and change its 
value range. 
 
Suggested Solutions 
 
When low CQI areas are discovered, consider the following: 
 

• Increase signal strength (RSRP) by optimizing coverage, deploying small cells, and improving antenna 
designs. 

• Reduce interference through proper cell planning, interference coordination, and advanced techniques 
like eICIC and beamforming. 

• Improve SNR by using adaptive power control and noise reduction techniques. 

• Leverage advanced antenna technologies like MIMO and beamforming. 

• Improve modulation and coding schemes for higher data rates and better CQI. 
 

Maximum Downlink Rate 
 
Maximum Downlink Rate refers to the highest data transfer rate that can be achieved in the downlink (from 
the base station to the mobile device) in a cellular network. This rate is a key indicator of network 
performance, particularly for users consuming data-intensive applications like video streaming, file 
downloads, or web browsing. 
 
The maximum downlink rate depends on a combination of factors, including standard (e.g., LTE, 5G), available 
bandwidth, signal quality, available modulation schemes, coding schemes, and network load. The rate is 
expressed in megabits per second (Mbps). 
 
This metric depends only on base station capabilities. It does not take into account UE. If you need to analyze 
throughput depending on specific user equipment, choose UE Downlink Rate or UE Uplink Rate 
visualizations.  



 

Double-clicking on the Maximum Downlink Rate legend on the status bar allows you to configure the color 
scheme and change its value range. 
 
Suggested Solutions 

 
When low expected PHY rate areas are discovered, you should focus on: 
 

• Increasing available bandwidth (via Carrier Aggregation or moving to mmWave band with huge 
channel width). 

• Leveraging advanced MIMO techniques (like massive MIMO and beamforming). 

• Optimizing modulation and coding schemes for higher efficiency. 
• Reducing interference by managing channel assignment. 

• Improving network load management with load balancing and small cells.  
 
 
 
UE Downlink/Uplink Rate 

 
The UE (User Equipment) Downlink/Uplink rate refers to the data transfer rate that the user device (such as 
a smartphone, tablet, or IoT device) can achieve when receiving data from the cellular network. This rate is 
a critical performance metric that directly impacts the end-user experience in terms of network activities like 
video streaming, web browsing, downloads, and other data-intensive tasks. 
 
The rate is expressed in megabits per second (Mbps) and depends on both: base station and UE capabilities 
and network conditions. 

 

 

Double-clicking on the UE Downlink/Uplink Rate legend on the status bar allows you to configure the color 
scheme and change its value range. 

 
Suggested Solutions 

 
When low UE Downlink/Uplink areas are discovered, first consider recommendations given for the Maximum 
Downlink Rate visualization and also consider: 
 

• Upgrade your clients to ensure the UE supports modern features like higher MIMO modes, 5G, 

 
When calculating UE rates, TamoGraph relies on the UE Capabilities settings, which may 
be more limited than the base station’s capabilities. If the UE’s capabilities are inferior, 
for example, if certain MIMO modes or modulation schemes are not supported, the 
maximum data rate supported by the base station will not be achievable. Please refer 
to the description of UE Capabilities for more information. 
 



 

mmWave band and advanced modulations for maximum performance. 
 

Overlapping Zone 
 
Overlapping zone represents the areas where the coverage from multiple base stations or cells overlaps. This 
occurs when the coverage areas of two or more neighboring base stations extend into the same geographic 
area. This is common behavior because it ensures continuous coverage as users move between cells, 
supporting handover between cells to maintain a seamless connection. Overlapping zones play a key role in 
managing network capacity. If one base station is overloaded, the network can offload some of the traffic to 
the neighboring base station, improving overall network performance. 
 
However, the overlapping area also introduces some challenges, such as potential interference and the need 
for coordination between the cells to optimize user experience. 
 
In TamoGraph, the Overlapping Zone visualization shows how many base stations provide coverage at each 
point on the map. It takes into account the PCI assigned to each base station, allowing you to assess how 
these overlaps will be perceived by client devices. 
 

 
Suggested Solutions 

 
If you discover unwanted coverage overlaps or, conversely, want to expand such overlap zones in locations 
where additional capacity is important, try the following: 
 

• Experiment with the placement of base stations on the floor plan and with their installation height. 

• Use directional antennas instead of dipole antennas. This allows you to fine-tune the coverage sector 
more precisely. 

• Evaluate the required base-station transmit power. This is a case where reducing power can help you 
manage overlap zones more effectively. 

• Check the assigned PCI identifiers. They determine how UEs distinguish signals from different stations 
within an overlap area. 

 
 

  



 

Coverage Areas 
 

This visualization shows the areas covered by the base stations. An area is considered covered if the signal is 
strong enough for the clients to communicate to the base station. You can select and deselect one or several 
of the base stations to see individual or group coverage areas. Coverage areas are color-coded: For each base 
station, a small colored square is shown next to the base station icon. The corresponding color is used to 
display the coverage area contour or fill. 
 

The definition of “strong enough” is rather subjective because certain signal strength might be sufficient for 
low data rates, but insufficient for the high data rates required for performance demanding applications. 
Additionally, UE vary in sensitivity, and some clients might be able to provide good connectivity in zones 
where others fail to connect altogether. 

 

The following options on the Visualization Settings panel (located on the  Options tab of the right-side panel) 
affect the way coverage areas are analyzed and visualized: 

 
 Base station coverage areas – this allows you to change the color-coding method used for displaying 

coverage areas. In No fill, contours only mode, the application draws contours of the coverage areas without 
filling the areas with colors. In Fill and mix colors mode, base station coverage areas are filled with colors; when 
areas overlap, the application draws a striped pattern, alternating the colors of the respective base stations. In 
Fill, the strongest base station on top mode, base station coverage areas are filled with colors; when areas 
overlap, the application draws the color of the strongest base station. In Fill, the weakest base station on top 
mode, base station coverage areas are filled with colors; when areas overlap, the application draws the color 
of the weakest base station. 

 
Requirements 
 
This visualization shows what requirements set by the user are met. The Requirements panel (located on the 
Properties tab of the right-side panel) allows the user to set thresholds for key cellular network parameters: 

 
• Minimum RSRP (shown as RSRP on the legend) 

• Minimum RSRQ (shown as RSRQ on the legend) 
• Minimum SINR (shown as SINR on the legend) 

• Minimum CQI (shown as CQI on the legend) 
• Minimum base station downlink rate (shown as BS↓ on the legend) 

• Minimum UE downlink rate (shown as UE↓ on the legend) 
• Minimum UE uplink rate (shown as UE↑ on the legend) 

The zones where the requirement is not met are marked with the corresponding legend color. If more than 
one requirement is not met, only one color will be used (priority is given to the requirements closer to the 
top of the list). If multiple base stations are required, the strongest base station will be checked against the 
requirement list. If all the requirements are met, no color overlays will be displayed. 



 

The meaning of the requirements listed above is explained in detail in the preceding sections of the Analyzing 
Data chapter. 

Double-clicking on the "Requirements" legend on the status bar allows you to configure the color scheme 
and change its value range. 



 

Reporting and Printing 
 

After performing a site survey and viewing its results in the main application window, you can create a report 
that contains all the information and visualizations related to your survey. To configure the report options 
and generate a report, click Project => Generate Report in the main application menu. 

 
The report generation dialog allows you to configure the following report options: 
 

• Plans and Surveys. This frame lists the available floor plans to be included in the report. By default, 
the selection of floor plans is the same as in the main application window. At the bottom of this frame, 
you can also see the indication of the Current Base Station selection mode, which tells you if the report 
will be generated for all or for only the selected base stations. Again, the selection is the same as in 
the main application window. If you want to change the base station selection mode, close the report 
dialog and change the mode, using the corresponding buttons on the toolbar of the main window.  

• Project information. Use the Surveyor, Location, and Description fields to specify additional 
information about your project. 

• Visualizations. This list allows you to select which visualizations you would like to see in the report by 
checking or unchecking the corresponding boxes. Check Map with no visualizations if you would like 
to have the original site map / floor plan included. Add per-BS visualizations is an important option 
that allows you to add additional visualizations for each of the selected base stations. For example, if 
you want to create a report for five base stations and include the RSRP visualization with the Add per-
BS visualizations option, the report will contain one cumulative RSRP visualization for all the five base 
stations and, additionally, five separate visualizations for each of the base stations. Without the Add 
per-BS visualizations option, the report will contain only one cumulative signal level visualization that 
includes data on all the five base stations. 
 
You can also add visualizations for secondary and tertiary coverage, i.e., coverage provided by the 
second- and third-strongest BS. To do that, you should click on the rectangle to the right of the 
visualization type. The rectangle displays the BS rank(s) to be included into the report: 1 for the default, 
standard visualization, where the metrics are shown for the strongest base station, 1+2 for the 
strongest and second-strongest base station, and 1+3 for the strongest and third-strongest base 
station. For more information, see Base Station Rank and Secondary Coverage. 

• Additional items to include. Check the corresponding boxes to include additional information 
pertaining to your site survey. Checking Base station list will add the table that lists all the base stations 
and if a DAS architecture is used, the table will also include an estimate of the required cable lengths 
for connecting each base station; checking Map descriptions will add the descriptions (if any) of the 
floor plan(s) entered by the user; checking Virtual Obstructions will display virtual obstructions, such 
as walls or attenuation areas, on the floor plan. Checking Media Objects will add images and notes you 
might have added to the project. 

• Output settings. Use the Format drop-down list to select the report format. You can choose between 
PDF, ODT (OpenDocument Text format that you can edit in Microsoft® Word or OpenOffice), HTML, 
HTML (single file). The difference between the HTML and HTML (single file) is that in the former, 
images are stored in a separate subfolder, whereas in the latter, images are embedded into a single 



 

.MHT file, which can be natively viewed only in Microsoft Internet Explorer. The Paper size drop-down 
list can be used to specify the size of the report pages: A4, A3, or Letter. You can also select a Page 
orientation: Portrait or Landscape. If you generate reports in PDF format, you can control the JPEG 
quality (the higher the quality is, the larger the file size will be) and the Embed fonts option. Embedding 
fonts increases the output file size considerably, but ensures that the file looks correct on any system, 
even if the fonts used in that file are not installed. 

• Object size factor. Depending on the floor plan dimensions and report page size, the objects in the 
report, such as base station icons, may appear too small or too large. Although the application tries to 
compute the best icon size for the given combination of plan dimensions and page size, you may want 
to adjust the object size manually by using this control. 

• Language. This control allows selecting the report language that does not necessarily match the 
language of the application user interface. For example, if the TamoGraph UI is English, you can 
generate a report in German. Currently, only English is supported. 

 
Once you have configured all the options, you may want to customize its look (fonts, colors, logos, etc.) by 
clicking Customize and then clicking Save to select the file name and have TamoGraph generate the report. 
Check the Open report after generation box to have the file opened by the associated viewer upon generation. 
If you would like to print the report without saving it to a file, click Print. Alternatively, you can first save the 
report and then print it from the associated viewer (Adobe Acrobat in the case of PDF files or your favorite 
browser in the case of HTML files). 

 

Customizing Reports 
 
The report customization dialog can be accessed by clicking the Customize button and checking the Enabled 
report customization box. By using the customization functionality, you can change text colors, fonts, logos, 
or add additional text to PDF or HTML reports. 

 
The following customization elements are available: 
 

• Heading #1 and Heading #2 – use these fields to modify the default report heading and subheading on 
the first report page. 

• Footer – use this field to modify the default footer text that is placed at the bottom of every report 
page except the first one. 

• Additional summary row and Additional summary text – use these fields to add a row to the report 
summary located on the first page. 

• Logo – this element allows you to replace the default logo on the first page. You can select an image 
in any common graphic format. 

• Colors – use this frame to set custom colors. #1 is for the heading on the first page; #2 is for other 
headings; #3 is for the background of the tables; #4 is for the table heading text color; #5 is for the 
main text color. 

• Fonts – use this frame to modify the default fonts. #1 is for the heading font; #2 is for the main text 
font. 

 



 

Additionally, you may want to Add a page before the report and/or Add a page after the report by checking 
the corresponding boxes. Clicking Edit opens an editor window where you can enter and format any text and 
specify the headings for the additional pages. 

To apply the new settings, click OK. To restore the default settings, click Default. 



 

Configuring TamoGraph 
 

Virtually all of the application and project settings can be configured using the right-side panel (if the panel 
is hidden, click View => Right Panel or click on the central part of the right splitter to have it displayed). This 
panel includes three tabs whose functionality is described below in detail. 

 
Plans and Surveys 

 
This tab displays a hierarchical list of the project floor plans or site maps, as shown below. 

 

This list is an important tool that allows you to add, rename, or delete floors (for multi-floor projects) and floor 
plans / site maps. The project hierarchy consists of floors, floor plans. The top hierarchy level is a floor, which 
contains one or several floor plans. Adding a floor is optional. Your project does not necessarily have to have 
the top-level floor node; when you create a new project, a floor level is not automatically created, and your 
floor plan becomes the top-level node. To add a new floor, click Add => Floor. To add a new plan, select the 
floor you want to add the plan to and click Add => Plan or Add => Street map, if you want to import a map 
from one of the online map services. To move a plan and related surveys to a newly created floor, simply select 
the plan with the mouse and drag it to the corresponding floor node. You can also use the context menu 
commands to Rename or Delete floors and floor plans. 

You can use the Comments column to add or modify comments for floor plans. The Floor Manager is a tool 
that may be used in multi-floor predictive models; more information can be found in the Working with Multi- 
Floor Sites chapter. 

 
Properties 

 
Using this tab, you can configure the project properties. It includes the following panels: Plan / Map, 
Environment, UE Capabilities, and Requirements. You can collapse or expand panels by clicking on the arrow 
button on the right-hand side of the panel. 

 
Plan / Map 

 



 

The Plan / Map panel can be used for editing the floor plan Map name, adding Description/Comments to 
the plan, and adjusting the image brightness and contrast, if the floor plan is too bright, too dark, or lacks 
contrast. If the floor plan image is colored, you may want to check the Discard color information box to 
convert it to grayscale, as grayscale images give you a clearer picture when overlaid with data visualizations. 

 
Environment 

 
The Environment panel allows you to configure some of the very important project parameters that affect 
the way data visualizations are computed. 

Because different environments have different characteristics in terms of signal attenuation, diffraction, 
reflection, etc., you are asked to Select an environment from the list. You should select the environment that 
best describes the site being surveyed. 

The Main Band parameter specifies the frequency band that will be used by default when working with this 
project. 

The Interference slider sets the level of external interference at the site. This is used to account for noise not 
directly related to the network being designed. 

The Network Utilization slider defines the average network load. The percentage should correspond to 
typical, not peak, load conditions. 

The Measurement units control can be used to choose the preferred units (feet or meters) for displaying 
distances and coordinates throughout the application. 

Finally, Cable laying method determines how the required cable length for base stations is calculated. The 
Cable length control switch enables or disables the function that prevents placing base stations at a distance 
that clearly exceeds the maximum allowable cable length. 

 
UE Capabilities 
 
This section of settings is used to define the characteristics of the client equipment (formally referred to as 
user equipment, UE). These characteristics determine the client’s capabilities and are primarily used for the 
UE Downlink/Uplink Rate visualizations, as well as in the Requirements visualization. 
 
Client equipment does not always support all the features provided by the base station. This may relate to 
supported modulation schemes or, for example, the number of MIMO streams. All of this affects the maximum 
performance available to the client. The Capabilities section is designed to simulate such client equipment. 
This allows you to view network performance from your clients’ perspective and potentially identify 
bottlenecks in both base-station configuration and placement. 
 
You can save UE settings as presets for future use. To do this, assign a name to the settings and click Save 
preset. Later, the saved preset can be loaded by selecting it from the drop-down list. 
 



 

Because the 4G/LTE and 5G standards differ significantly in configuration options and the variety of client 
devices, TamoGraph provides two separate sets of UE Capabilities settings—one for each standard. 

UE Capabilities 4G LTE 
 
Tx/Rx streams specifies the number of supported MIMO streams for transmission and reception, 
respectively. 

 
Max transmit power defines the maximum transmit power of the client radio. 

 
The three switches at the bottom of the panel specify the client’s ability to support modern modulation 
schemes such as 64QAM and 256QAM 
 

 
UE Capabilities 5G NR 
 
The UE Capabilities panel for 5G has two sections for the Sub-6 GHz (FR1) and mmWave (FR2) bands. The set 
of available parameters is identical for both sections: 
 
Tx/Rx streams define the number of MIMO streams supported for transmission and reception, respectively. 
 
Max. DL/UL BW specifies the channel bandwidth in MHz for each transmission direction. 
 
EIRP sets the transmit power of the client radio. 
 
As in 4G, both bands share a set of switches that control support for modern modulation schemes such as 
256QAM. 
 
Finally, at the bottom of the panel, the user can specify the Beamforming gain. This parameter defines the 
amount of signal gain achieved through directional phased-array transmission toward the receiver (not 
supported by all equipment). 
 

Requirements 
 

Using the Requirements panel, you can configure the requirements that your cellular network should meet. The 
configuration that you create will be used for displaying the Requirements visualization. This visualization is helpful 
for a quick and easy evaluation of the overall health of your network and detection of potential issues. You can set 
thresholds for the following parameters (click on the links for the detailed description of the corresponding items): 
 

• Minimum RSRP 

• Minimum RSRQ  

• Minimum SINR 

• Minimum CQI 

• Minimum BS downlink rate 



 

• Minimum UE downlink rate 

• Minimum UE uplink rate 
 
To facilitate requirements configuration, three presets are available: Basic (for basic, low throughput 
connectivity), Medium, and Advanced (for high throughput, redundant connectivity). You can select a preset 
from the drop-down list, adjust the values, or create your own by clicking on the New button, typing a preset 
name, and then clicking the Save button. You can also delete presets by clicking on the Delete button. 

 
Options 

 
This tab allows you to configure the application options. It includes the following panels: Colors and Value 
Ranges, Visualization Settings,  Tips, Computations, and Miscellaneous. You can collapse or expand panels by 
clicking on the arrow button on the right-hand side of the panel. 

 
Colors and Value Ranges 

 
Using this tab, you can configure color schemes, drawing styles, and value ranges used in visualizations 
overlaid on top of the floor plan or site map.  

You can also choose between several Visualization schemes that will be used for visualizations, such as RSRP 
or Link Rate. Checking the Smooth colors box makes the transition between colors smooth. Checking the 
Invert colors box inverts the colors in the selected visualization scheme. If you would like to see the contours 
between areas of different color, check the Contour box. 

Using the Value Ranges section, you can configure the range of values represented by the selected color 
scheme for the RSRP, RSRQ, SINR, CQI, BS downlink rate, UE downlink rate, UE uplink rate visualizations. 
For example, if you selected the color scheme that ranges from red to blue and a RSRP value range from -130 
dBm to -50 dBm, any area where the signal level is equal to or below -130 dBm will be shown in red, and any 
area where the signal level is equal to or above -50 dBm will be shown in blue. Additionally, you can adjust 
the Steps value (i.e., the number of distinct colors to be used). Using the same example, the entire value 
range from -130 to -50 dBm would be 80 dBm; setting the Steps value to 10 would mean that every 8 dBm, 
a new color would be used to display the RSRP level and the total number of distinct colors zones would be 
10. Setting the Steps value to 20 would double the number of distinct colors, making the color overlay much 
smoother. 
 
Click the Reset button below the value ranges to revert to the default range settings. 
 
Visualization Settings 

 
The following settings affect the way TamoGraph displays some visualizations: 
 
Base station coverage areas – This setting allows you to change the color-coding method used for displaying 
coverage areas. In No fill, contours only mode, the application draws contours of the coverage areas without 



 

filling the areas with colors. In Fill and mix colors mode, the base stations’ coverage areas are filled with colors; 
when areas overlap, the application draws a striped pattern, alternating the colors of the respective base 
stations. In Fill, the strongest base station on top mode, base station coverage areas are filled with colors; 
when areas overlap, the application draws the color of the strongest base station. In Fill, the weakest base 
station on top mode, base stations’ coverage areas are filled with colors; when areas overlap, the application 
draws the color of the weakest base station. This setting is applicable to the following visualization: Coverage 
Areas. 

Grayscale obstructions – This setting controls whether virtual objects are displayed in color or grayscale 
mode. Available options are Always, When applying visualizations, and Never. 

 
Tips Panel 
 
The tips panel is a small panel that is shown at the bottom of the application window; it displays useful tips 
and tricks that help you perform certain tasks. You can control whether to show tips when performing RF 
Planning and Selecting multiple obstruction objects by checking or unchecking the corresponding 
checkboxes. Experienced users may want to turn off tips altogether to free more space for the floor plan. By 
default, all tips are enabled. 

 
Computations 
 
The following settings affect the way TamoGraph performs heavy computational tasks needed for predictive 
RF models: 

Use GPU for faster computations – Check this box if you want TamoGraph to use the computational 
resources of your graphics processing unit (also known as “video card”). If your computer is equipped with a 
modern, fast GPU (preferably a discrete, dedicated one), selecting this option will make computations of 
complex RF models much faster. Note that this option is disabled if your GPU is not supported or if you are 
running a 32-bit TamoGraph version. 

Allow background computations – This option is turned off by default. Check this box if you want TamoGraph 
to conduct computations in the background. For example, if this option is turned on, once you have opened 
a project with a predictive model, TamoGraph will start computing the model before you select any 
visualization. These saves time when you actually select a visualization to work with the model. Please turn 
on this option only if you running TamoGraph on a very powerful computer to ensure that other tasks are 
not slowed down due to the background computations. 

 
Miscellaneous 

 
The following miscellaneous options are available: 

Load last opened project at startup – Check this box if you want TamoGraph to automatically load the last 
project you worked on (if any) when the application starts. 

Autosave a project backup – Check this box if you want to save a separate backup copy of the project 
whenever potentially risky or time-consuming operations are performed on the open project. You can specify 



 

the location for saving these backup copies and define how many of the most recent copies should be kept. 
Set the value to “0” for an unlimited number of copies. Note: this function is disabled by default. 

Custom base station names are used globally – Check this box if you want TamoGraph to use custom base 
station names throughout all the projects that you work with on a given computer. When this box is not 
checked, custom BS names are project-specific. 

Show base station labels on the map – Check this box if you want TamoGraph to display a small label with 
the base station name next to each base station on the floor plan. 

Ignore multitouch features – Check this box if you want TamoGraph to ignore the fact that you are running 
it on a computer with a multitouch display. When TamoGraph detects a multitouch display, it makes certain 
changes to the interface elements to make them more convenient to use. For example, pane splitters become 
wider, and so on. If you do not need these changes, you can use this option to force TamoGraph to use a 
standard user interface. Enabling or disabling this option requires a restart. 

Smart map scrolling – Select when you want TamoGraph to use smart map scrolling. Smart map scrolls the 
map automatically whenever you click or tap next to the map edge, eliminating the need to scroll the map as 
you move along your path. 

Enable automatic updates – Check this box if you want TamoGraph to connect to the TamoSoft and see 
whether a new TamoGraph version is available. When this option is enabled, TamoGraph checks for updates 
once a week. 
 

 

  



 

Command-Line Options and Configuration Settings for 

Advanced Users 

A few command-line options are available for customizing the application’s behavior. 

Those commands are intended for advanced users; please do not modify the registry or edit configuration 
files unless you know exactly what you are doing or unless you have been asked to do that by our technical 
support team. 

/debug – turns on writing debug information to a log file and writing captured packets to a capture file. Our 
technical support team may request these files for troubleshooting complex problems. The output file name 
is debug.log and it is located on the Windows Desktop folder. 

/gpu_force_bench – forces TamoGraph to re-evaluate OpenCL compatibility of the connected GPU devices 
and to re-run benchmark tests for them in order to check their performance. 

Certain advanced TamoGraph configuration settings cannot be accessed via the user interface; such settings 
can be edited in the registry. 

 

 
The parameters listed below are located under the following registry branch: 
 

HKEY_CURRENT_USER\SOFTWARE\TamoGraph LTE and 5G Edition 

 
BSLabelTemplate – defines the format of information displayed on base station labels. A base station label 
is a line of text that can include one or several of the following variables: 

%n – base station ordinal number according to the base station list on the left application panel. 
%m – base station name 
%b - Band 
%c – Channel(s) 
%r – base station maximum downlink rate 

If the parameter is empty, the labels will show only base station names. Note that this parameter affects only 
the base station labels; it does not affect the base station names saved as part of the project. 

MinZoomPercent / MaxZoomPercent – defines the minimum and maximum zoom factor in percent for the 
floor plans displayed by TamoGraph. 

SaveVisAPIconFactor – this parameter controls the magnification in percent of base station icons when you 
use the Save Visualization As… function. If you want to make base station icons larger, specify a value > 100. 
To make them smaller, specify a value below 100. 

  

 
Close TamoGraph before editing these settings! 



 

RFPlanner\FloorNeighborhoodDepth – defines how many floors above and below the specific floor are taken 
into consideration when computing signals in predictive models. By default, this value equals 1, which means 
that signals from base stations located one floor above and one floor below are computed. Note that 
increasing the value of this parameter slows down calculations. 

Some user settings and presets are stored as separate files. These files can be manually edited. All the files 
that are listed below use UTF-16 encoding. 

These files are located in: 
 
C:\ProgramData\TamoSoft\TamoGraph LTE and 5G Edition 

 
areas.user – custom attenuation area presets (applicable to predictive RF Modeling).  
floor_ceiling.user – custom floor/ceiling material presets (applicable to predictive RF Modeling).  
obstructions.user – custom walls and doors presets. 
stations.user – custom base station presets (they include antenna information + base station-specific values 
of band, rate, power, etc.) 



 

Frequently Asked Questions 
 
 
Q1. Does TamoGraph support multi-floor projects? 

A. Yes, you can create projects with multiple floors in TamoGraph. If you perform predictive modeling, simply 
add new floors in Floor Manager, add floor plans for each floor, define floor height and material, and then 
align the floors. 

 

Q2. It appears that there are very few virtual base station templates and all of them are for generic base 
stations. How do I create a virtual base station that simulates a specific model by a major cellular equipment 
vendor? 

Virtual base stations can be constructed like Lego. For example, if you want to simulate a specific base station, 
start with a suitable Generic Base Station template. Place the base station on the floor map, double-click it, 
configure its properties to match the physical unit you plan to deploy (e.g., channel width or output power), 
and then select the antenna type. TamoGraph includes many vendor-specific external antennas in its 
database. In other words, you assemble Lego-like building blocks to create a model that matches the real 
base station. You can then save this configuration as a new template and reuse it in future projects. Naturally, 
it’s impossible to include every antenna in our database, so if there is a specific antenna you would like us to 
add and its radiation patterns are publicly available, just let us know and we’ll include it in TamoGraph. 



 

Sales and Support 
 

At TamoSoft, we want you to be happy with your purchase. That is why we encourage you to try our products 
and technical support free of charge for 30 days before you make a decision regarding your purchase. By 
making the most of these free evaluations, you can fully test the software and make sure that it does 
everything you need. When you are ready to buy, we welcome you to https://www.tamos.com/order to 
order directly from us or through our partners and resellers. 

As a registered user, you will receive: 
 

• A fully functional, unrestricted copy of the software. 
• Free updates that will be released within one year from the date of purchase.    

• Information on updates and new products. 
• Free technical support. 

 
Prices, terms, and conditions are subject to change without notice. Please check our website for the latest 
product offerings and prices. 
 
For technical support, please visit https://www.tamos.com/support. 

 

https://www.tamos.com/order
https://www.tamos.com/support
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